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 AN4833
 File Transfer Protocol Using MPLAB Harmony v3 TCP/IP

Stack for SAM E54 MCU

Introduction
The File Transfer Protocol (FTP) is a standard internet protocol provided by TCP/IP for transmitting files from one
device to another. It is an application layer protocol within the TCP/IP stack layers. An embedded FTP client/server
is an excellent addition to any network-enabled device. The FTP client module will enable your application to upload
and download files from any FTP server. This protocol enables data transfer reliably and efficiently between different
devices without worrying about the file storage systems of a Host.

This document focuses on the FTP implementation of the MPLAB® Harmony v3 TCP/IP stack. It also provides a
combined FTP client and FTP server demonstration using the SAM E54 microcontroller. The FTP client application
has an Ethernet bootloader that downloads the application binary from the FTP server and updates the firmware by
self-programming.

Abbreviations

• FTP: File Transfer Protocol
• HTTP: Hypertext Transfer Protocol
• TCP/IP: Transmission Control Protocol/Internet Protocol
• DHCP: Dynamic Host Configuration Protocol
• DFP: Device Family Pack
• MCC: MPLAB Code Configurator



 AN4833

© 2022 Microchip Technology Inc.
and its subsidiaries

 Application Note DS00004833A-page 2

Table of Contents

Introduction.....................................................................................................................................................1

1. FTP Overview......................................................................................................................................... 3

2. Application Overview...............................................................................................................................4

3. Hardware and Software Requirements................................................................................................... 5

4. FTP in MPLAB Harmony v3.................................................................................................................... 6

4.1. TCP/IP Configurator.....................................................................................................................6
4.2. FTP Server Module...................................................................................................................... 7
4.3. FTP Client Module........................................................................................................................7

5. FTP Client and Server: Application Implementation............................................................................. 10

5.1. MPLAB Harmony v3 Configuration............................................................................................ 10
5.2. TCP/IP MPLAB Harmony v3 Configuration................................................................................10
5.3. Running the Application............................................................................................................. 14

6. Appendix............................................................................................................................................... 19

6.1. Generating Application Binary Files (Test Application Configurations)...................................... 19
6.2. Self-Programming of Downloaded Binary.................................................................................. 21
6.3. Application Code Entry...............................................................................................................22

7. References............................................................................................................................................23

Microchip Information...................................................................................................................................24

The Microchip Website..........................................................................................................................24
Product Change Notification Service.................................................................................................... 24
Customer Support................................................................................................................................. 24
Microchip Devices Code Protection Feature.........................................................................................24
Legal Notice.......................................................................................................................................... 24
Trademarks........................................................................................................................................... 25
Quality Management System................................................................................................................ 26
Worldwide Sales and Service................................................................................................................27



 AN4833
FTP Overview

© 2022 Microchip Technology Inc.
and its subsidiaries

 Application Note DS00004833A-page 3

1. FTP Overview
FTP is built on a client/server model architecture using separate control and data connections between the client and
the server. An FTP client establishes a connection between a Host and a remote FTP server, providing dual-direction
data transfer and files between two computers over TCP. It works when the client connects to the FTP server
by specifying the domain, IP address, port, username, and password. After user authentication, a connection is
established between both systems, and the Host computer can upload data onto the FTP server. There could be
access restrictions, which the FTP server administrator determines for downloading the various files and folders
residing on the FTP server.

The FTP relies on two connections between the client and server: a control connection for controlling the
conversation and a data connection for transmitting file content. When an FTP session is started between a
client and a server, the client initiates a control TCP connection with the server side. The client sends the control
information over this. When the server receives the control information, it initiates a data connection to the client side.
FTP sessions work in active or passive mode, determining how the data connection is established and whether the
client/server initiates the transfer. Additional information on FTP modes and connections can be found in the FTP
document AN3475.

https://ww1.microchip.com/downloads/en/Appnotes/File-Transfer-Protocol-Using-MPLAB-Harmonyv3-TCPIP-DS00003475A.pdf
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2. Application Overview
This document demonstrates the use of an FTP server and an FTP client in a network by using two SAM E54
Xplained Pro Evaluation Kits, where one will be the FTP server and the other evaluation board will be the FTP client.
Each FTP client and FTP server has its own file system media. The SD card on the IO1 Xpro board acts as the
storage medium for the file system and is used by the client/server boards for the file transfer. This application mainly
focuses on the FTP network where the client logs into the server and downloads the application binary file to load the
application.

Figure 2-1. SAM E54 as Client and Server Model
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3. Hardware and Software Requirements
This section describes the hardware and software prerequisites used for this application.

Hardware:

• SAM E54 Xplained Pro Evaluation Kit – 2 Nos
• IO1 Xplained Pro – 2 Nos
• Micro SD card – 2 Nos
• Ethernet cable (RJ45) – 1 No
• USB cable – 2 Nos

Software:

• MPLAB X IDE (v6.00)
• MPLAB XC32 compiler (v4.10)
• MPLAB Code Configurator (v5.1.17)

– Harmony bsp repository v3.13.0 (Github bsp)
– Harmony csp repository v3.13.1 (Github csp)
– Harmony core repository v3.11.1 (Github core)
– Harmony dev_packs repository v3.13.0 (Github dev_packs)
– Harmony net repository v3.8.0 (Github net)
– Harmony Crypto repository v3.7.6 (Github crypto)

https://github.com/Microchip-MPLAB-Harmony/bsp
https://github.com/Microchip-MPLAB-Harmony/csp
https://github.com/Microchip-MPLAB-Harmony/core
https://github.com/Microchip-MPLAB-Harmony/dev_packs
https://github.com/Microchip-MPLAB-Harmony/net
https://github.com/Microchip-MPLAB-Harmony/crypto
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4. FTP in MPLAB Harmony v3
The MPLAB Harmony v3 TCP/IP Stack Library provides the API of the FTP module with a convenient 'C' language
interface. It supports the FTP server and client, which facilitates the upload and download of files.

4.1 TCP/IP Configurator
MPLAB Harmony v3 configuration uses an easy-to-use GUI, the MPLAB Code Configurator (MCC), which simplifies
device setup, library selection, configuration, and application development. A TCP/IP Configurator plugin is available
for the TCP/IP Configuration. This enables a user to graphically add or remove TCP/IP functionality to the MPLAB
Harmony v3 project and configure each component per the application demand. The TCP/IP Configurator plugin can
be selected from the Plugins drop-down list in the Project Graph window.

Figure 4-1. TCP/IP Configurator

The TCP/IP Configurator window initializes with a graphical overview of the different TCP/IP layers. Selecting each
layer displays the available components. Choose the component needed for the application from the 'Available
Components' list by clicking '+' or dragging and dropping to add selected components. A pop-up window will
be shown for adding any unsatisfied dependencies on the component being selected. Select any added TCP/IP
component and add the configuration in the 'Configuration Options' in the project Graph.

Figure 4-2. TCP/IP Configurator Overview

Note: The 'docs' folder in the local repository of 'net' contains more information on the configurator.

https://www.microchip.com/mplab/mplab-harmony
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4.2 FTP Server Module
The FTP server capability facilitates the uploading and downloading of files from an embedded device. The FTP
TCP/IP stack library interface is defined in the ftp.h header file. To use the FTP server, the project requires using
the TCP/IP stack and a file system (FAT FS in this project).

The FTP server can be enabled in the MPLAB Harmony v3 TCP/IP project using the MCC: Project Graph > Plugin >
TCP/IP Configuration > Application Layer > Add FTP Server.

Figure 4-3. FTP Server in TCP/IP Configurator

Table 4-1. FTP Server Module Files

File Description

ftp.h Interface to the FTP server TCP/IP Stack library

ftp.c Implementation of FTP server

4.3 FTP Client Module
The FTP client module enables the transfer of data reliably and efficiently between different devices without worrying
about the different file storage systems among Hosts. The FTP client TCP/IP stack library interface is defined in the
ftpc.h header file.

The FTP client can be enabled in the MPLAB Harmony v3 TCP/IP project using the MCC: Project Graph > Plugin >
TCP/IP Configuration > Application Layer > Add FTP Client.
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Figure 4-4. FTP Client in TCP/IP Configurator

Table 4-2. FTP Client Module Files

File Description

ftpc.h Interface to the FTP client TCP/IP stack library

ftpc.c Implementation of the FTP client protocol

The following table displays the FTP commands supported by the FTPC module.

Table 4-3. FTP Commands Supported by the FTPC Module

FTP COMMAND STACK COMMAND TYPE FUNCTION NAME

USER: Send username TCPIP_FTPC_CMD_USER TCPIP_FTPC_Login
PASS: Send password TCPIP_FTPC_CMD_PASS TCPIP_FTPC_Login
ACCT: Send account information TCPIP_FTPC_CMD_ACCT TCPIP_FTPC_Login
TYPE: Set transfer type TCPIP_FTPC_CMD_TYPE TCPIP_FTPC_SetType
STRU: Set file transfer structure TCPIP_FTPC_CMD_STRU TCPIP_FTPC_SetStruct
MODE: Set transfer mode TCPIP_FTPC_CMD_MODE TCPIP_FTPC_SetMode
PASV: Enter passive mode TCPIP_FTPC_CMD_PASV TCPIP_FTPC_SetPassiveMode
PORT: Open a data port TCPIP_FTPC_CMD_PORT TCPIP_FTPC_Connect
RETR: Retrieve a remote file TCPIP_FTPC_CMD_GET TCPIP_FTPC_GetFile
STOR: Store a file on the remote host TCPIP_FTPC_CMD_PUT TCPIP_FTPC_PutFile
NLST: Name list of remote directories TCPIP_FTPC_CMD_NLST TCPIP_FTPC_NameList
LIST: List remote files TCPIP_FTPC_CMD_LIST TCPIP_FTPC_List
DELE: Delete a remote file TCPIP_FTPC_CMD_DELE TCPIP_FTPC_DeleteFile
CWD: Change working directory TCPIP_FTPC_CMD_CWD TCPIP_FTPC_Change_Dir
CDUP: CWD to the parent of the current
directory

TCPIP_FTPC_CMD_CDUP TCPIP_FTPC_ChangeToParentDir
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...........continued
FTP COMMAND STACK COMMAND TYPE FUNCTION NAME

MKD: Make a remote directory TCPIP_FTPC_CMD_MKD TCPIP_FTPC_MakeDir
RMD: Remove a remote directory TCPIP_FTPC_CMD_RMD TCPIP_FTPC_RemoveDir
PWD: Print working directory TCPIP_FTPC_CMD_PWD TCPIP_FTPC_Get_WorkingDir
QUIT: Terminate the connection N/A TCPIP_FTPC_Logout

In addition to implementing the FTP commands, the client module provides a user interface through the USART
terminal. This enables users to provide the required FTP command by entering the terminal. All FTP client
commands start with the keyword ‘ftpc’, for example, ftpc login <username> <pswd> .
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5. FTP Client and Server: Application Implementation
This section covers the prerequisites for creating the application.

5.1 MPLAB Harmony v3 Configuration
• To create a 32-bit MPLAB Harmony v3 project for the SAME54P20A using MPLAB X IDE, refer to https://

microchipdeveloper.com/harmony3:same54-getting-started-training-module.
• By default, the Device Family Pack (DFP), System, CMSIS Pack, NVMCTRL and EVSYS will be present when

the configuration is launched.
• The SD Card (SPI) Driver is added to provide the interface for the SD Card from the IO1 Xplained Pro Board.
• The System services, including the CONSOLE, COMMAND, DEBUG, TIME, File System, and TCP/IP features,

must be added along with the required satisfiers as shown below.

Figure 5-1. FTP Client/Server Project Graph

5.2 TCP/IP MPLAB Harmony v3 Configuration
To configure TCP/IP Basic Configurator for client and server, use the following steps:

1. The TCP/IP Configurator will open a window as mentioned in the TCP/IP Configurator section. Once the
selected contents are added, a view can be observed through the TCP/IP Configurator or the Project Graph.
Different views can be selected through the Project Graph as shown in the following figure:
Figure 5-2. Selecting Views

2. In the Basic Configuration view, TCPIP CMD and TCPIP CORE components are enabled.

https://microchipdeveloper.com/harmony3:same54-getting-started-training-module
https://microchipdeveloper.com/harmony3:same54-getting-started-training-module
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Figure 5-3. Basic Configurator

Note: In the TCP/IP CORE configuration options, the TCP/IP Stack Dynamic RAM size can be adjusted per
the application requirement.

3. The network interface is configured to the necessary PHY connection in the Data Link configuration options.
Ensure that the required network details, such as IP address and gateway address, are configured for both
the client and the server. The internal ethernet driver (GMAC) is enabled with the KSZ8091 PHY driver for
the SAME54 demonstration. The SAME54 Xplained Pro Evaluation Kit has the KSZ8091 present. The MIIM
Driver supports asynchronous read/write and scan operations for accessing the external PHY registers and
notifications when the MIIM operations have been completed.
Figure 5-4. Data Link Configuration
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Figure 5-5. NETCONFIG Options

Note: This configuration of the network components can be done either by clicking the components on the project
graph, or clicking the components in the TCP/IP configuration plugin. This is also applicable to other TCP/IP network
components of the MPLAB Code Configurator's graphical user interface (GUI).

5.2.1 FTP Server Configurations
TCP/IP Application Layer Configuration

Follow these steps to configure the TCP/IP Application Layer:

• In the TCP/IP Configuration window, under TCP/IP Layers, click "Application".
• In the Application Layer view, the TCP/IP Application Layer Configurator enables the following components:

ANNOUNCE, FTP SERVER, DHCP Server, SNTP and DNS CLIENT.
• The ANNOUNCE module facilitates device discovery on the DHCP-enabled networks, while the DHCP CLIENT

module allows the application to dynamically obtain an IP address from a DHCP server on the network.
Note: The addition of the FTP server component would be sufficient for an FTP server project and the FTP
client component would be sufficient for an FTP client project along with DNS. Those mentioned above are
additional network protocols.

Figure 5-6. FTP Server Application Layer Configuration
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• The FTP server uses the FAT FS to access files from SDCARD media. In the FTP SERVER configuration,
configure the FTP server root directory path as shown in the following figure:
Figure 5-7. FTP Server Configuration

5.2.2 FTP Client Configuration
TCP/IP Application Layer Configuration

Follow these steps to configure the TCP/IP Application Layer:

• For client, in the TCP/IP Application Layer Configurator, the ANNOUNCE, FTP CLIENT, and DHCP CLIENT
components are enabled:
Figure 5-8. FTP Client Application Layer Configurator View

• In the FTP CLIENT Configuration, the Enable console commands option allows users to interact with the FTP
client through a serial terminal. The transmit and receive buffer size can be increased as required (up to 1,024
bytes).
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Figure 5-9. FTP Client Configuration

5.3 Running the Application

5.3.1 Hardware Setup
Follow these steps to setting up the hardware:

1. Attach the IO1 Xpro board to the EXT1 of the SAME54 Xplained Pro Evaluation Kit.
2. Insert the Micro SD card into the Micro SD card slot on the backside of the IO1 Xpro boards. Ensure that the

SD Card in the FTP Server contains the binary (test.bin) to be downloaded by the FTP Client.
3. Connect the micro-USB cable from the computer to the DEBUG USB connector on the SAM E54 Xplained Pro

Evaluation Kit.
4. Connect the RJ45 ports of both SAM E54 Xplained Pro Evaluation Kits through the RJ45 cable, as shown in

the following figure:
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Figure 5-10. SAM E54 Client/Server Connection

5.3.2 Programming the MCU
Follow these steps to program the MCU:

1. Download the FTP client and FTP server projects (provided with this document, alternatively users can
download it here FTP Client and FTP Server).

2. Open the project in MPLAB X IDE (File > Open Project
and then browse to same54_ftp_client\firmware\ftp_client_sam_e54_xpro.X and
same54_ftp_server\firmware\ftp_server_sam_e54_xpro.X).

3. Build and program the project to the target board by clicking  (make and program device icon) for both
boards, the client project (ftp_client_sam_e54_xpro) in one SAM E54 Xplained Pro Evaluation Kit board,
and the server project (ftp_server_sam_e54_xpro) in the other.

5.3.3 Connecting FTP Server
Follow these steps to connecting the FTP server:

1. Power up the FTP Server board through the Debug USB port.
2. Flash the FTP Server project in the SAM E54 Xplained Pro Evaluation Kit FTP Server Board and open the

terminal (Tera Term) same54_ftp_server\firmware\ftp_server_sam_e54_xpro.X .
3. After Flashing, the FTP Server will complete the initialization and the console will print the server IP address

as shown in the following figure.

https://github.com/Microchip-MPLAB-Harmony/reference_apps/releases/latest/download/same54_ftp_client.zip
https://github.com/Microchip-MPLAB-Harmony/reference_apps/releases/latest/download/same54_ftp_server.zip
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Figure 5-11. FTP Server Console Output

Note: Before connecting to the SAM E54 FTP client project (Ethernet bootloader), copy the application binary
file (same54_ftp_client/utilities/test.bin) to the MicroSD Card in the IO1 Xpro extension of the
FTP Server board. This binary will be downloaded by the client and performs the bootloading.

5.3.4 Connecting FTP Client
The user application for an FTP client must initiate the FTP connection request. Based on the server's response to
the request, the client must provide the username and password for logging in. Data can be transferred between the
server and the client when the FTP client is successfully logged in. (The user’s own client/server, such as Windows
Client, Embedded Server/Embedded Client, or Linux server, and so on can be used for the application).

In this application, the client downloads a binary file from the server and the downloaded file will be stored on an SD
card on the IO1 Xpro of the client board. The binary is then programmed to the microcontroller.
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Figure 5-12. Flow Diagram of FTP Bootloader in the FTP Client
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Use the following steps to connect to the FTP client:

1. From a serial terminal window application (Tera Term), connect to the COM port enumerated by the SAM E54
Xplained Pro Evaluation Kit.

2. Restart the application (reset the SAM E54 Xplained Pro Evaluation Kit).
3. The IP address will be displayed on the terminal as shown in the following figure.

Figure 5-13. FTP Client Initialization

4. The user can then connect to the FTP server by typing: ftpc connect <server ip address>.
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5. Upon successful connection, enter the login details: ftpc login <username> <password>.
6. Once logged in, use the following ftpc to get the command to download a binary from the server:

ftpc get -a -a <test.bin>. The 'Command Success' indicates the binary is successfully downloaded.
7. Once the 'Command Success' message is received, enter the command 'boot'. The 'boot' is the command

defined to start the bootloading of the downloaded binary.
8. The MCU is reset after the programming is complete and the application code starts executing.

Notes: 
• The Binary files must be used for downloading and bootloading.
• The source code contains a same54_ftp_client/utilities/test.bin for LED Flashing. This binary

must be saved in the SD Card of the SAM E54 Xplained Pro Evaluation Kit programmed with the SAME54 FTP
server project.

Figure 5-14. Output
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6. Appendix

6.1 Generating Application Binary Files (Test Application Configurations)
Typically, the embedded firmware has the bootloader programmed at the base address of the Flash memory. The
application image follows the bootloader code in the Flash memory. To generate the binary file of an application
project in MPLAB X IDE, perform the steps as shown in the following sections.

6.1.1 Disable Generate Fuse Settings
Generally, the fuse configuration settings of the SAM MCU are programmed through the programming tool. The fuse
settings are disabled in the test application, as the application is being programmed through the bootloader. Enabling
the fuse settings increases the size of the binary file.

6.1.2 Modify Application Start Address (Hex)
The application start address value must be equal to or greater than the Flash base address + bootloader size. It
must match the value provided to the bootloader code during the generation. The bootloader will use the application
start address value to jump to the application at the device reset.

The fuse settings and the application start address can be modified using the MCC. Launch the MCC and configure
the 'System' component as shown in the following figure.

Figure 6-1. System Setting Configuration in MCC

To change the application's start address, navigate to Project Properties > xc32-ld > Option categories: Symbols &
Macros. Users need to define the ROM_ORIGIN and ROM_LENGTH macros.
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Figure 6-2. Project Properties

6.1.3 Generate the Binary File in MPLAB X IDE
To generate the binary file, follow these steps:

1. Go to Project Properties > Building.
2. Select Execute this line after build option, and then insert the following command:

${MP_CC_DIR}\xc32-objcopy -I ihex -O binary "${DISTDIR}/${PROJECTNAME}.$
{IMAGE_TYPE}.hex" 
"${DISTDIR}/${PROJECTNAME}.${IMAGE_TYPE}.bin"
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Figure 6-3. Bin File Generation

After building the project. The bin file output can be found in the following path:
<your_project>.X\dist\<config_name>\production\.

6.2 Self-Programming of Downloaded Binary
Users can download the required application binary from any FTP server (any FTP server can be used)
using the FTP client application demonstrated in this document. Once the binary file is downloaded into the
client file system, it can be programmed to the MCU's Flash memory, as shown in the following flow chart.
Implementation of erasing and programming the Flash sector can be found in the APP_Flash_Task() function
(same54_ftp_client\firmware\src\app.c) in the source code of this application.
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Figure 6-4. Programming the Binary
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6.3 Application Code Entry
Upon every reset, the bootloader code checks for the following:

• User button press (SW0)
• A valid application code in the Flash address allocated for the application

If either of these conditions is true, the execution jumps to the user application code without executing the FTP client
bootloader.

Note: For additional information, refer to this document AN3475.

https://ww1.microchip.com/downloads/en/Appnotes/File-Transfer-Protocol-Using-MPLAB-Harmonyv3-TCPIP-DS00003475A.pdf
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https://www.youtube.com/watch?v=KdhltTWaDp0
https://www.youtube.com/watch?v=PRewTzrI3iE
https://microchipdeveloper.com/harmony3:mcc-overview
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Microchip Information

The Microchip Website
Microchip provides online support via our website at www.microchip.com/. This website is used to make files and
information easily available to customers. Some of the content available includes:

• Product Support – Data sheets and errata, application notes and sample programs, design resources, user’s
guides and hardware support documents, latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical support requests, online
discussion groups, Microchip design partner program member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip press releases, listing of
seminars and events, listings of Microchip sales offices, distributors and factory representatives

Product Change Notification Service
Microchip’s product change notification service helps keep customers current on Microchip products. Subscribers will
receive email notification whenever there are changes, updates, revisions or errata related to a specified product
family or development tool of interest.

To register, go to www.microchip.com/pcn and follow the registration instructions.

Customer Support
Users of Microchip products can receive assistance through several channels:

• Distributor or Representative
• Local Sales Office
• Embedded Solutions Engineer (ESE)
• Technical Support

Customers should contact their distributor, representative or ESE for support. Local sales offices are also available to
help customers. A listing of sales offices and locations is included in this document.

Technical support is available through the website at: www.microchip.com/support

Microchip Devices Code Protection Feature
Note the following details of the code protection feature on Microchip products:

• Microchip products meet the specifications contained in their particular Microchip Data Sheet.
• Microchip believes that its family of products is secure when used in the intended manner, within operating

specifications, and under normal conditions.
• Microchip values and aggressively protects its intellectual property rights. Attempts to breach the code

protection features of Microchip product is strictly prohibited and may violate the Digital Millennium Copyright
Act.

• Neither Microchip nor any other semiconductor manufacturer can guarantee the security of its code. Code
protection does not mean that we are guaranteeing the product is “unbreakable”. Code protection is constantly
evolving. Microchip is committed to continuously improving the code protection features of our products.

Legal Notice
This publication and the information herein may be used only with Microchip products, including to design, test,
and integrate Microchip products with your application. Use of this information in any other manner violates these
terms. Information regarding device applications is provided only for your convenience and may be superseded

https://www.microchip.com/
https://www.microchip.com/pcn
https://www.microchip.com/support
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by updates. It is your responsibility to ensure that your application meets with your specifications. Contact your
local Microchip sales office for additional support or, obtain additional support at www.microchip.com/en-us/support/
design-help/client-support-services.

THIS INFORMATION IS PROVIDED BY MICROCHIP "AS IS". MICROCHIP MAKES NO REPRESENTATIONS
OR WARRANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL, STATUTORY
OR OTHERWISE, RELATED TO THE INFORMATION INCLUDING BUT NOT LIMITED TO ANY IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY, AND FITNESS FOR A PARTICULAR PURPOSE,
OR WARRANTIES RELATED TO ITS CONDITION, QUALITY, OR PERFORMANCE.

IN NO EVENT WILL MICROCHIP BE LIABLE FOR ANY INDIRECT, SPECIAL, PUNITIVE, INCIDENTAL, OR
CONSEQUENTIAL LOSS, DAMAGE, COST, OR EXPENSE OF ANY KIND WHATSOEVER RELATED TO THE
INFORMATION OR ITS USE, HOWEVER CAUSED, EVEN IF MICROCHIP HAS BEEN ADVISED OF THE
POSSIBILITY OR THE DAMAGES ARE FORESEEABLE. TO THE FULLEST EXTENT ALLOWED BY LAW,
MICROCHIP'S TOTAL LIABILITY ON ALL CLAIMS IN ANY WAY RELATED TO THE INFORMATION OR ITS USE
WILL NOT EXCEED THE AMOUNT OF FEES, IF ANY, THAT YOU HAVE PAID DIRECTLY TO MICROCHIP FOR
THE INFORMATION.

Use of Microchip devices in life support and/or safety applications is entirely at the buyer's risk, and the buyer agrees
to defend, indemnify and hold harmless Microchip from any and all damages, claims, suits, or expenses resulting
from such use. No licenses are conveyed, implicitly or otherwise, under any Microchip intellectual property rights
unless otherwise stated.

Trademarks

The Microchip name and logo, the Microchip logo, Adaptec, AVR, AVR logo, AVR Freaks, BesTime, BitCloud,
CryptoMemory, CryptoRF, dsPIC, flexPWR, HELDO, IGLOO, JukeBlox, KeeLoq, Kleer, LANCheck, LinkMD,
maXStylus, maXTouch, MediaLB, megaAVR, Microsemi, Microsemi logo, MOST, MOST logo, MPLAB, OptoLyzer,
PIC, picoPower, PICSTART, PIC32 logo, PolarFire, Prochip Designer, QTouch, SAM-BA, SenGenuity, SpyNIC, SST,
SST Logo, SuperFlash, Symmetricom, SyncServer, Tachyon, TimeSource, tinyAVR, UNI/O, Vectron, and XMEGA are
registered trademarks of Microchip Technology Incorporated in the U.S.A. and other countries.

AgileSwitch, APT, ClockWorks, The Embedded Control Solutions Company, EtherSynch, Flashtec, Hyper Speed
Control, HyperLight Load, Libero, motorBench, mTouch, Powermite 3, Precision Edge, ProASIC, ProASIC Plus,
ProASIC Plus logo, Quiet- Wire, SmartFusion, SyncWorld, Temux, TimeCesium, TimeHub, TimePictra, TimeProvider,
TrueTime, and ZL are registered trademarks of Microchip Technology Incorporated in the U.S.A.

Adjacent Key Suppression, AKS, Analog-for-the-Digital Age, Any Capacitor, AnyIn, AnyOut, Augmented Switching,
BlueSky, BodyCom, Clockstudio, CodeGuard, CryptoAuthentication, CryptoAutomotive, CryptoCompanion,
CryptoController, dsPICDEM, dsPICDEM.net, Dynamic Average Matching, DAM, ECAN, Espresso T1S,
EtherGREEN, GridTime, IdealBridge, In-Circuit Serial Programming, ICSP, INICnet, Intelligent Paralleling, IntelliMOS,
Inter-Chip Connectivity, JitterBlocker, Knob-on-Display, KoD, maxCrypto, maxView, memBrain, Mindi, MiWi, MPASM,
MPF, MPLAB Certified logo, MPLIB, MPLINK, MultiTRAK, NetDetach, Omniscient Code Generation, PICDEM,
PICDEM.net, PICkit, PICtail, PowerSmart, PureSilicon, QMatrix, REAL ICE, Ripple Blocker, RTAX, RTG4, SAM-
ICE, Serial Quad I/O, simpleMAP, SimpliPHY, SmartBuffer, SmartHLS, SMART-I.S., storClad, SQI, SuperSwitcher,
SuperSwitcher II, Switchtec, SynchroPHY, Total Endurance, Trusted Time, TSHARC, USBCheck, VariSense,
VectorBlox, VeriPHY, ViewSpan, WiperLock, XpressConnect, and ZENA are trademarks of Microchip Technology
Incorporated in the U.S.A. and other countries.

SQTP is a service mark of Microchip Technology Incorporated in the U.S.A.

The Adaptec logo, Frequency on Demand, Silicon Storage Technology, and Symmcom are registered trademarks of
Microchip Technology Inc. in other countries.

GestIC is a registered trademark of Microchip Technology Germany II GmbH & Co. KG, a subsidiary of Microchip
Technology Inc., in other countries.

All other trademarks mentioned herein are property of their respective companies.
© 2022, Microchip Technology Incorporated and its subsidiaries. All Rights Reserved.

ISBN: 978-1-6683-1675-7

https://www.microchip.com/en-us/support/design-help/client-support-services
https://www.microchip.com/en-us/support/design-help/client-support-services
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Quality Management System
For information regarding Microchip’s Quality Management Systems, please visit www.microchip.com/quality.

https://www.microchip.com/quality
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AMERICAS ASIA/PACIFIC ASIA/PACIFIC EUROPE
Corporate Office
2355 West Chandler Blvd.
Chandler, AZ 85224-6199
Tel: 480-792-7200
Fax: 480-792-7277
Technical Support:
www.microchip.com/support
Web Address:
www.microchip.com
Atlanta
Duluth, GA
Tel: 678-957-9614
Fax: 678-957-1455
Austin, TX
Tel: 512-257-3370
Boston
Westborough, MA
Tel: 774-760-0087
Fax: 774-760-0088
Chicago
Itasca, IL
Tel: 630-285-0071
Fax: 630-285-0075
Dallas
Addison, TX
Tel: 972-818-7423
Fax: 972-818-2924
Detroit
Novi, MI
Tel: 248-848-4000
Houston, TX
Tel: 281-894-5983
Indianapolis
Noblesville, IN
Tel: 317-773-8323
Fax: 317-773-5453
Tel: 317-536-2380
Los Angeles
Mission Viejo, CA
Tel: 949-462-9523
Fax: 949-462-9608
Tel: 951-273-7800
Raleigh, NC
Tel: 919-844-7510
New York, NY
Tel: 631-435-6000
San Jose, CA
Tel: 408-735-9110
Tel: 408-436-4270
Canada - Toronto
Tel: 905-695-1980
Fax: 905-695-2078

Australia - Sydney
Tel: 61-2-9868-6733
China - Beijing
Tel: 86-10-8569-7000
China - Chengdu
Tel: 86-28-8665-5511
China - Chongqing
Tel: 86-23-8980-9588
China - Dongguan
Tel: 86-769-8702-9880
China - Guangzhou
Tel: 86-20-8755-8029
China - Hangzhou
Tel: 86-571-8792-8115
China - Hong Kong SAR
Tel: 852-2943-5100
China - Nanjing
Tel: 86-25-8473-2460
China - Qingdao
Tel: 86-532-8502-7355
China - Shanghai
Tel: 86-21-3326-8000
China - Shenyang
Tel: 86-24-2334-2829
China - Shenzhen
Tel: 86-755-8864-2200
China - Suzhou
Tel: 86-186-6233-1526
China - Wuhan
Tel: 86-27-5980-5300
China - Xian
Tel: 86-29-8833-7252
China - Xiamen
Tel: 86-592-2388138
China - Zhuhai
Tel: 86-756-3210040

India - Bangalore
Tel: 91-80-3090-4444
India - New Delhi
Tel: 91-11-4160-8631
India - Pune
Tel: 91-20-4121-0141
Japan - Osaka
Tel: 81-6-6152-7160
Japan - Tokyo
Tel: 81-3-6880- 3770
Korea - Daegu
Tel: 82-53-744-4301
Korea - Seoul
Tel: 82-2-554-7200
Malaysia - Kuala Lumpur
Tel: 60-3-7651-7906
Malaysia - Penang
Tel: 60-4-227-8870
Philippines - Manila
Tel: 63-2-634-9065
Singapore
Tel: 65-6334-8870
Taiwan - Hsin Chu
Tel: 886-3-577-8366
Taiwan - Kaohsiung
Tel: 886-7-213-7830
Taiwan - Taipei
Tel: 886-2-2508-8600
Thailand - Bangkok
Tel: 66-2-694-1351
Vietnam - Ho Chi Minh
Tel: 84-28-5448-2100

Austria - Wels
Tel: 43-7242-2244-39
Fax: 43-7242-2244-393
Denmark - Copenhagen
Tel: 45-4485-5910
Fax: 45-4485-2829
Finland - Espoo
Tel: 358-9-4520-820
France - Paris
Tel: 33-1-69-53-63-20
Fax: 33-1-69-30-90-79
Germany - Garching
Tel: 49-8931-9700
Germany - Haan
Tel: 49-2129-3766400
Germany - Heilbronn
Tel: 49-7131-72400
Germany - Karlsruhe
Tel: 49-721-625370
Germany - Munich
Tel: 49-89-627-144-0
Fax: 49-89-627-144-44
Germany - Rosenheim
Tel: 49-8031-354-560
Israel - Ra’anana
Tel: 972-9-744-7705
Italy - Milan
Tel: 39-0331-742611
Fax: 39-0331-466781
Italy - Padova
Tel: 39-049-7625286
Netherlands - Drunen
Tel: 31-416-690399
Fax: 31-416-690340
Norway - Trondheim
Tel: 47-72884388
Poland - Warsaw
Tel: 48-22-3325737
Romania - Bucharest
Tel: 40-21-407-87-50
Spain - Madrid
Tel: 34-91-708-08-90
Fax: 34-91-708-08-91
Sweden - Gothenberg
Tel: 46-31-704-60-40
Sweden - Stockholm
Tel: 46-8-5090-4654
UK - Wokingham
Tel: 44-118-921-5800
Fax: 44-118-921-5820

https://www.microchip.com/support
https://www.microchip.com
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